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1 What is Rep IV?
Rep IV is a suite of tools supporting research into, and applications of, a range of conversational
constructivist methodologies based on George Kelly’s (1955) Personal Construct Psychology
(PCP—see also Fransella (2003)). In its various versions, it aims to provide personal,
professional and research support for promoting understanding of individual and communal
psychological and social processes. It provides conversational tools for constructing and
analyzing grids (RepGrid), and nets (RepNet). Grids are a generalization of Kelly’s repertory
grids for eliciting construct networks through examples of their application, and nets are a
generalization of visual syntactic structures used for representing construct networks directly in
visual languages. It supports the use of grid and net tools separately and in combination,
including integration between those tools and other applications such as text editors.
The RepGrid tool is the most recent in a series of grid tools originating in 1975 on the PDP12 as
part of Mildred Shaw’s research on repertory grid elicitation and analysis through conversational
interaction with personal computers. Previous versions of the software include PLANET,
RepGrid 2, KSS0, NEXTRA and WebGrid. The RepNet tool is the most recent in a series of
programs for drawing the nodes and arcs of networks originating in 1965 on the PDP7 as part of
Brian Gaines’ research on interactive automata simulation and its application to modeling and
emulating human skills. Previous versions of the software include the inductive modelers, MA
CHERIE and ATOM, the semantic network system, KMap, and various other visual language
tools. These tools have been widely used in areas such as education, psychology, management
studies, artificial intelligence, knowledge acquisition, market research and personnel assessment.
1.1 The Personal version of Rep IV (see Section 10 for information on other versions)
The Centre for Person-Computer Studies (CPCS) was formed in the UK in 1968 as a not-forprofit organization to support research and development in interactive computers and their
application. One objective of CPCS is to promote understanding and application of personal
construct psychology by making constructivist psychological techniques as widely available as
possible. We have made repertory grid elicitation and analysis available for the last decade as
interactive web services through a freely accessible WebGrid server at the University of Calgary
(http://tiger.cpsc.ucalgary.ca). This has been used by tens of thousands of colleagues world-wide,
most of whom we do not know, and has supported research resulting in numerous graduate
theses and research papers as well as classroom and personal studies.
The Personal version of Rep IV furthers this endeavor by making grid and net tools, freely
available for personal (non-commercial) use. We have simplified the functionality as much as
possible to make it easy to use, and hope that it will find a place in schools and in courses
introducing students to personal construct psychology and the representation of construct
networks through grids and nets. It should also allow anyone interested in the techniques to
explore them personally as they see fit. The greater functionality of the other versions is built on
the same foundations with similar user interfaces, so that this version may also be used to
explore potential applications of the more powerful versions. For many uses involving the
individual analysis of grids with up to 15 elements and 15 constructs the Personal version may
suffice—our intention is that it should be adequate for many applications.
This manual is an introduction to the Rep IV Personal version functionality. It does not cover
how to apply grids and nets—a list of useful materials is provided at the end of the manual.
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2 What do you need to run Rep IV
There are two programs implementing the Personal version of Rep IV, one running on the
Macintosh under OS X 10.3 (and 10.2, but not OS9), and the other under Windows XP (and to a
large extent under 2000, NT and 98, but not 95).
Increasingly users move back and forth between machines using different operating systems,
concerned only to use whatever is available to perform a task. We have attempted to make the
Mac and Windows versions of Rep IV as similar as possible while respecting the look-and-feel of
the different operating systems. Fortunately Microsoft and Apple have already done much to
make this possible and reasonable.
Rep IV supports use of a two-button mouse designed originally for Windows on a Mac if
available. Otherwise the “control” key may be used as in other applications to mimic a rightbutton click if the cursor has a menu icon appended showing that a popup menu is available.
Two of the modifier keys are named slightly differently between Windows and Mac, but modern
keyboards are double-labeling them to overcome this problem. This manual uses the prefix:
“ALT” to indicate that the “alt” key (Windows) or “option” key (Mac) should be depressed at the
same time as another key; “CMD” to indicate that the command (or apple) key (Mac) or control
key (Windows) should be used in this way.
2.1 Getting started
Windows: Rep IV is distributed as a “setup.exe” file for Windows XP which contains an installer
program. Download this file and an installer wizard will take you through a conventional
installation sequence and install the Rep IV program files in your “Program Files” directory, and
a “Rep IV Support” directory containing example data and the manual in your “MyDocuments”
directory. It also installs an uninstaller that can be used to remove the files it has installed.
The Rep IV application may be started in the usual way from the “Rep IV” directory under the
Windows “Start” menu, by double-clicking on the “Rep IV” shortcut on the desktop or by
dragging a data file to it, or by clicking on a grid or net file.
Macintosh: Rep IV is distributed as a “installer.dmg.gz” compressed disk image file for OS X
10.3. Download this file and run the installer from your downloads folder. The installer wizard
will take you through a conventional installation sequence and install the Rep IV program files in
your “Applications” folder, and a “Rep IV Support” directory containing example data and the
manual in your “Documents” directory. It also installs an uninstaller that can be used to remove
the files it has installed.
The Rep IV application may be started in the usual way by double-clicking on it, by dragging a
data file to it or by double-clicking on a grid or net data file.
2.2 Data compatibility
Rep IV recognizes and supports all the data formats we have used in previous grid and net
programs. It will read the files generated by PLANET, RepGrid 1,2 and 3, KSS0, NEXTRA,
WebGrid, and KMap, as well as importing data from spreadsheets in the format we defined for
Repgrid 2.
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Since PLANET source code was distributed widely and its data format was adopted in other
repertory grid analysis packages, Rep IV may also read data prepared for some of them. The
simple format used is one of the most rapid ways of coding manually elicited grids as datasets
for computer analysis, and Rep IV supports it being pasted or dragged from a text editor
(including the built-in text editor) into the grid edit and analyze tool.
2.3 Unicode and the support of the language scripts of the world
Rep IV manages data in both grids and nets in Unicode (UTF-8) representation so that it will
support their use in the wide range of language scripts of the world available in Unicode
(provided your computer has been configured to do so). An illustration of grid analysis with
element and construct labels pasted in from samples of non-English languages is shown below.

Unicode support illustration
All Rep IV files are text files that are distinguished in type by their contents not by operating
system conventions. This makes them portable across platforms and also readily generated or
opened by other applications.
Rep IV also supports cut-and-paste and drag-and-drop between its own components and other
applications, so that grids and nets can be developed from a variety of sources with the minimum
of typing.
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3 The Rep IV Manager window
When you start Rep IV by clicking on its icon you will first see the Rep IV manager window
shown below. This window may be closed at any time, and reopened as needed from the
“Window” menu or by keying CMD-R.

The Rep IV manager window
The buttons on this screen, in various groupings, may be used to activate all the major
functionality of Rep IV. Some of this can also be done from the “File” menu but the panel is
usually more convenient.
Grid functions: The group of six buttons on the left allows you to create a new grid, open an
existing one in a file for editing, copy an existing one as a new version, or copy it without ratings
for exchange grid studies, or with only elements or only constructs. An error message is shown if
the file selected is not a grid.
Net functions: The group of four buttons in the upper center allows you to create a new net,
open an existing one in a file for editing, copy of an existing one as a new version, or copy just
its syntactical structure of node and line types. An error message is shown if the file selected is
not a net.
Text functions: The group of two buttons in the lower center allows you to create a new text
editing window or open any existing file for editing in a text editing window (including grids and
nets which can be useful if you wish to look at the file formats).
Version information: The large button on the right shows you the version of Rep IV that you are
using. If your computer is connected to the Internet then clicking on this button will cause your
web browser to access the page at repgrid.com covering Rep IV, its versions and updates.
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4 The Rep IV menus
Below is shown the Rep IV menu bar with menus: “File,” “Edit,” “Windows,” “Help.”

Rep IV menu bar on Mac and Windows
Below is shown the Rep IV “File” menu with the “New” sub-menu to the right that can be used
to create new grid, net or text files. The “Open…” command, or CMD-O, will open any grid, net
or text file, treating an unrecognized file as if it were text.

Rep IV “File” menu on Mac and Windows (with “New” clicked)
Below is shown the Rep IV “Edit” menu. “Text” opens a font/style dialog for text windows.

Rep IV “Edit” menu on Mac and Windows
Below is shown the Rep IV “Windows” menu. At the top “Rep IV Manager” opens the “Rep IV”
Window as shown in Section 3. The open windows are listed below and each may be selected to
bring it to the front.

Rep IV “Windows” menu on Mac and Windows
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5 Grid editing and analysis: RepGrid
The RepGrid tool in Rep IV provides the capability to enter, edit and elicit repertory grid data,
and to reflect back the underlying psychological processes in graphic form. It includes scripts for
conversational elicitation (Shaw, 1980), and for the entry of grids that have been elicited through
interviews (Jankowicz, 2003; Fransella, Bell and Bannister, 2004; Fromm, 2004). The analyses
present grids in a way that reflects their meaning to promote discussion, understanding, decisionmaking, conflict mediation, and further elicitation.
We will first show the RepGrid tool in operation with an existing file and then discuss how to
enter your own data or elicit it through conversational interaction with RepGrid. Clicking on the
“Open Grid” button in the Rep IV Manager window brings up the dialog for opening a file, if a
file is selected RepGrid will attempt to open it as a grid, reporting an error if it cannot.
5.1 RepGrid window
Below is the RepGrid window that appears when the grid selected is opened. The tab ribbon
along the top lets you select any one of the the panes: “Status,” “Elements,” “Constructs,” and
“Scripts.” The “PrinGrid,” “Focus,” and “Display” buttons at the lower right provide immediate
PrinGrid, Focus and Display analyses respectively (Section 7).

RepGrid window with “Status” pane showing
When the data in a RepGrid window is changed the “Save” item in the “File” menu becomes
active as does the “Undo” item in the “Edit” menu. You can save the changed data under its
original name through the “Save” command. The “Save As…” command in the “File” menu is
always active and lets you save the grid in a different file. RepGrid supports multi-level undo
through the “Undo” command at the top of the “Edit” menu (or CMD-Z).
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The RepGrid window opens with the “Status” pane showing, and clicking on one of the other
tabs brings its pane into view. The following sections describe the functions of each pane.
5.2 Status pane
The “Status” pane shows some overall features of the grid and allows them to be entered or
edited. The “Grid Description” panel comprises four items. The “Name” field is intended to
identify the person from whom the grid was elicited. This is used to identify the grid in the titles
of the analyses, but since several grids might be elicited from the same person, a “Note” field is
provided to allow further identification. You will see in the analysis that RepGrid entitles this
grid, “Arthur (after class discussion).”
The “Topic” field is used to identify the topic area or domain for the grid. Unlike the “Note”
field, this field is not shown in any of the current analyses, and it can be used as one sees fit to
annotate the grid.
The “Purpose” field is used to express the purpose or context for eliciting the grid. Computerbased elicitation tools use this field to remind the user of the reason why they are developing a
grid, and the analysis tools put it in the title to show the purpose or context of the elicitation.
The “Terminology and Defaults” panel comprises five items. In grids the entities being construed
are termed “elements” and the dimensions of construing, their perceived characteristics, are
termed “constructs.” These are somewhat technical terms, and it is often better for users to
substitute more colloquial terms appropriate to the domain or topic under consideration. In this
grid Arthur, or the person facilitating the elicitation, has chosen to use the term “situation” for
“element” and “quality” for “construct.”
The rating scale in the Personal version of Rep IV may be set to be from 1 to 2, 3, 5, 7 or 9. All
are commonly used. A two-valued rating scale of 1 to 2 forces the user to make binary
distinctions without “shades of gray.” Using 1 to 3 provides a middle option that allows a user to
express neutrality between the two poles of a construct. However, users often prefer to have the
further gradations of a 1 to 5, 1 to 7 or 1 to 9 scale available to them. In the literature you will
also find a variety of other scales used, for example a –7 to +7 scale, and the more advanced
versions of RepGrid cater to such usage. In the Personal version we have simplified the choices
to those most commonly found useful.
You may change the rating scale as you add constructs, and thus have constructs with different
rating scales in the same grid. RepGrid will analyze such grids correctly since it rescales the
constructs to a common range as part of its analyses. However, having different rating scales for
different constructs is not a common usage of grids, and we do not recommend that this feature
be used except in special circumstances.
5.3 Elements pane
Clicking on the “Elements” tab brings up the pane shown below. This lists the numerical order of
the elements in the grid in the column on the left, their names in the next column, and the rating
values on a particular construct in the column on the right. The construct to which these ratings
apply is selected through the popup menu at the top right. The “Add” button at the bottom right
adds an additional element row.
Rows may be selected by clicking in the number column on the left which selects and highlights
the row clicked. Multiple rows may be selected by holding down the “shift” key for contiguous
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selections and the CMD key for non-contiguous selections, consistent with the normal
conventions of the Mac and Windows operating systems. The main purpose of selecting rows in
the Personal version is to allow them to be deleted by pressing the “delete” or “backspace” key.
It also allows the data in them to be dragged to another application as will be discussed in
Section 9.

RepGrid “Elements” pane
The element names may be edited by clicking on them which makes them editable as shown
below. When the name has been edited, pressing the “return” or “enter” key or clicking
elsewhere re-centers the name. Pressing the “tab” key makes the element name in the next lower
box editable.

Clicking on an element name selects it for editing
Pressing the “tab” key when the last element name is editable adds a new element and makes its
name editable, as if one had clicked the “Add” button at the bottom right of the “Elements” pane.
Ratings may be edited in the same way as names by clicking on them to make then editable and
typing in a new rating. The “tab” key now sequences down through the ratings, and has no effect
if pressed in the last one. Ratings may also be edited by bringing up the popup menu indicated by
the changed cursor shape as one mouses over a rating, as shown below.

Mouse cursor changes to indicate a popup menu is available to edit a rating
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Popup menus are activated on a Mac by CTL-click and on Windows (or a Mac with a two-button
mouse) by a right-click. Below is shown a rating being edited through a popup menu. This may
be done even if the rating value has not been made editable for keyboard editing.

Popup menu editing a rating
5.4 Constructs pane
Clicking on the “Constructs” tab in the RepGrid window brings up the pane shown below. This
lists the numerical order of the constructs in the grid in the column on the left, their left hand
pole (LHP) names in the next column, their right hand pole (RHP) names in the next column,
and the rating values on a particular element in the column on the right. The element to which
these ratings apply is selected through the popup menu at the top right.
Editing constructs in this pane is much the same as for elements described above. Rows may be
selected for deletion with the “delete” or “backspace” key, and added by clicking the “Add”
button or keying “tab” when the bottom RHP of a construct is editable. The only significant
difference is that the “tab” key steps from LHP to RHP and then to the LHP of the next
construct. Ratings may be edited through the keyboard or popup menu as for elements.

RepGrid “Constructs” pane
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5.5 Scripts pane
Clicking on the “Scripts” tab in the RepGrid window brings up the pane shown below with the
script button/popup menu at the top right clicked to bring up a popup menu of available scripts.
This button is dual-purpose in that clicking in the menu symbol on the right (or right-clicking
anywhere in the button) brings up a menu which enables one to select the script named in the
button, and clicking in the script name causes the script to run. A script may be terminated at
any time by pressing the “esc” key.

RepGrid “Scripts” pane
The scripts supplied with the “Personal” version of Rep IV are “Elicit Grid” and “Enter Grid.”
Selecting one of these from the popup menu starts it running, and the purpose and behavior of
these scripts is described in the next section.
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6 Grid entry and elicitation scripts
The scripts accessible through the “Scripts” pane are designed to support rapid entry of existing
grid data, and conversational elicitation of new grids.
6.1 Enter Grid script
The “Enter Grid” script allows existing grid data to be entered rapidly. The script is programmed
to:1. Request missing fields in the “Status” window such as the user’s name and the purpose of
the elicitation
2. To ask the user to enter the elements
3. To ask the user to enter the constructs and their ratings on the elements
4. To offer the user the option to edit and enter more elements or constructs, or to finish the
entry process
The “Enter Grid” script may be run immediately with a new grid, or with one where the name
and purpose have been entered on the “Status” pane, and/or the elements have been entered on
the “Elements” pane. If the rating scale is other than 1 to 5 or the terms for elements and
constructs are different then these should be set up in the “Status” pane before the script is
run. In the example below elements have been termed “situations” and constructs “qualities.”
The script offers the facility to edit elements, constructs and ratings, and this may also be done
through the “Elements” and “Constructs” panes. The “Display” button provides a convenient
way of checking the data entered against its source to ensure that it is correct.
The figures below illustrate the “Enter Grid” script being used to enter the grid used to illustrate
this manual. The first screen shows the name and purpose being entered as text terminated by the
“return” key.

“Enter Grid” script entering name and purpose
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The entry process is similar to that of a text editor. The “delete” key may be used to erase text,
and text may be selected, copied and pasted.
After the purpose has been entered, the element names are entered as shown below. An empty
name terminates the element entry and proceeds to the constructs and ratings entry.

“Enter Grid” script entering element names
The next screen shows the pole names of the first construct being entered.

“Enter Grid” script entering pole names of the first construct
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Then the ratings on each element are requested as shown below. They can be typed in as
numbers followed by “return”, or by clicking the mouse and selecting a rating from a popup
menu.

“Enter Grid” script entering element ratings on the first construct
When all the elements have been rated on the first construct, the pole names of the second
construct are requested, and so on, until all the constructs and ratings have been entered.
Construct entry is terminated when an empty pole name is entered, and grid editing options are
listed as shown below.

“Enter Grid” script options after grid entry
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The “Display” button may be used to display the grid to check that it has been entered correctly.
If not, the elements or constructs may be listed and the names or ratings may be edited. The
screen below shows the elements and gives options to add more or to edit an element.

“Enter Grid” script list of elements
Clicking on the element “practical” displays its name and its rating on each construct as shown
below.

“Enter Grid” script editing a selected element
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Clicking on the option to delete the element displays the warning and options below.

“Enter Grid” script deleting a selected element
Clicking on the name makes it available for editing as shown below.

“Enter Grid” script editing an element name
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Clicking on a construct makes the rating available for editing as shown below.

“Enter Grid” script editing an element rating on a construct
Similarly, the constructs may be listed for editing as shown below.

“Enter Grid” script list of constructs
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Clicking on a construct displays it for editing as shown below. The editing procedures for the
pole names and the ratings are essentially the same as those described above for the elements.

“Enter Grid” script editing a selected construct
The grid may also be edited by clicking on the “Status,” “Elements” or “Constructs” tab and
using editing facilities described in Section 5. If the grid is edited in this way and then the
“Scripts” tab is clicked to return to a running script, the script is automatically restarted to show
the options so that no incorrect information is displayed on the screen.
Since the script’s actions derive from the data in the grid it may be started, restarted or stopped
(press “esc” key) at any time. In particular, the grid editing capabilities of the “Enter Grid” script
may be used with an existing grid if the user prefers them to those described in Section 5.
6.2 Elicit Grid script
The “Elicit Grid” script emulates the behavior of Shaw’s (1980) interactive repertory grid
elicitation program, PEGASUS. The script is programmed to:1. Request missing fields in the “Status” window such as the user’s name and the purpose of
the elicitation
2. To ask the user to enter six or more elements
3. To elicit constructs from triads of elements until there are four
4. To check element and construct matches and offer the user the opportunity to enter more
constructs or elements to break the matches
5. To offer the user the option to elicit more constructs from triads, edit and enter elements
or constructs, or to finish the elicitation
6. To ask the user to rate the elements on any given constructs when the elicitation process
is finished
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7. To modify the elicitation process appropriately to elicit ratings for “exchange” grids in
which the elements and constructs are given but the ratings are open, “elements” grids in
which the “elements” are given, and “constructs” grids in which the constructs are given.
Once steps 1 through 3 are complete the scripts loop between steps 4 and 5. At any time during
the elicitation the user can click on the “Analysis” menu or the “Display,” “Focus,” or
“PrinGrid” buttons to display or analyze the grid, and then continue the elicitation.
The “Elicit Grid” script operates in a similar way to the “Enter Grid” script except that, as shown
below, the interaction is more tutorial with greater explanation.

“Elicit Grid” script entering name and purpose
The initial elements are entered in much the same way as for the “Enter Grid” script as shown
below. The element elicitation section of the script can be edited to accommodate more specific
requests for particular types of element as, for example, might be appropriate to a “role grid”
requesting that family members and friends be entered, a core competency grid requesting that
employees with different types and levels of skills be entered, or a market research grid
requesting that products of certain categories and qualities be entered.
The “Elicit Grid” script differs from the “Enter Grid” script primarily in that it elicits constructs
using triadic elicitation in which the user is asked in which way two elements are alike and differ
from a third, and in the feedback of element and construct matches to prompt the elicitation of
further constructs and elements to reduce the matches (Shaw, 1980).
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“Elicit Grid” script entering element names

“Elicit Grid” script eliciting a construct from a triad of elements
When the user clicks on an element in the triad the screen below is shown which elicits the
construct pole names and ratings.
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“Elicit Grid” script entering construct pole names and element ratings
When all the elements have been rated the screen below is shown which makes the pole names
and ratings available for editing as has been shown for the “Edit Grid” script. Since the process is
now one of elicitation rather than data entry it is likely that the user will not be content with the
ratings as initially entered and will edit them at this point as shown in the second screen.

“Elicit Grid” script editing the elicited construct pole names and element ratings
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“Elicit Grid” script with the elicited construct pole names and element ratings after editing
Construct elicitation continues with further explanation and another triad of elements as shown
below.

“Elicit Grid” script eliciting a construct from a second triad of elements
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When four constructs have been elicited through triads the script tests for matches between
constructs and between elements and, if it finds any above eighty per cent, asks the user to enter
an element or construct to reduce the match as shown below.

“Elicit Grid” script breaking a construct match
The user clicks on “involvement and rigid,” enters a new element “programmed text”, and rates
it on each of the constructs as shown below.

“Elicit Grid” script entering an element to break a construct match
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When the new element has been rated the name and ratings can be edited as already shown. The
test for matches continues and notes an element match which prompts the elicitation and rating
of a new construct as shown below.

“Elicit Grid” script entering a construct to break an element match
The process continues with a match being found between the constructs “self-organised—stafforganised” and “small-group—large group” which might prompt the elicitation of another
element. When there are no further matches various options for further elicitation are listed as
shown below.

“Elicit Grid” script options
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The options are the same as those for the “Enter Grid” script with the addition of one for triadic
elicitation. As shown below selecting this now also provides an option for the user to select some
or all the elements of the triad.

“Elicit Grid” script selecting elements for a triad
The user can also use the editing facilities to add and rate elements and constructs directly. The
test for matches is applied each time the user enters an item so that further feedback is given if
appropriate. This process of elicitation from triads and matches, and entry and editing, proceeds
until the user is satisfied that the grid is relatively complete and chooses the option to finish.
Before finishing a check is made for unrated constructs such as “given constructs” provided by
the facilitator and the user is asked to rate the elements on these if there are any.
The “Display,” “Focus” and “PrinGrid” buttons may be used during the elicitation to supply an
interim analysis of the grid which may itself prompt the entry of further elements and constructs
or the editing of the grid.
The “Elicit Grid” script can be run with an existing a grid at any time to elicit further elements or
constructs and will automatically skip steps 1, 2 or 3, if the grid already contains the appropriate
data. For example, one can prepare a grid for use by others with the purpose specified as “to
understand people I know,” with “person” as the term for an element, “people” for elements,
“characteristic” for construct, “characteristics” for constructs, and with initial elements “self”
and “ideal self.” Running the “Elicit Grid” script set starting with a copy of this grid will result in
the user being asked their name, being asked for additional examples of people, having four
initial constructs elicited from triads, and then being taken through an elicitation process for
further elements and constructs. One can also enter some given constructs such as
“powerful—powerless” that capture an important aspect of the purpose of the elicitation, and, as
already noted, the script will ask the user to rate the elements on these as they finish.
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To facilitate comparison of grids the Rep IV manager window (Section 3) allows one to open a
copy of an existing grid with the ratings reset to be open (“Exchange”) or with the constructs
removed (“Elements”) or the elements removed (“Constructs”). Another user, or the same user at
a later time, can fill in the ratings and add constructs and elements to such grids for comparison
with original. It first requests the user’s name. The “Elicit Grid” script supports elicitation
commencing with such partial copies of grids. It first requests the user’s name and then: with
“Exchange” grids it asks the user to rate all the elements on each construct in turn; with
“Elements” grids it proceeds immediately to triadic construct elicitation; with “Constructs” grids
it requests elements and then asks the user to rate all the elements on each construct in turn. It
then offers the normal options.
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7 Grid display and analysis
This section describes the action of the “Display,” “Focus,” and “PrinGrid” buttons at the lower
right of a RepGrid window
7.1 Display
Below is the plot produced when you press the “Display” button. The title, constructs, elements
and ratings are shown. The plot may be saved as a net and edited in RepNet.

RepGrid graphic display of the data in the grid
7.2 Focus sorting and hierarchical clustering
Below is the plot produced when you press the “Focus” button.

RepGrid graphic plot of a Focus cluster analysis of the grid
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The grid has been sorted to bring closely matching elements together, and closely matching
constructs together. This manual does not cover the interpretation of grid analyses but there
several books that do so (Shaw, 1980; Shaw, 1981; Shaw and McKnight, 1981; Denicolo and
Pope, 2001; Jankowicz, 2003).
7.3 PrinGrid spatial rotation
Below is the plot produced when you press the “PrinGrid” button.

RepGrid graphic plot of a PrinGrid spatial analysis of the grid
The grid has been treated as if the elements were points plotted in an n-dimensional space
defined by the constructs as axes centered on the means of the elements. The data has then been
rotated through principal components analysis to spread the elements out as much as possible in
a 2-dimensional plot. Slater (1976; 1977) is the definitive work on such analysis of grids. Joliffe
(1986) is a good general source on principal components analysis. Gower (1966) is the definitive
work on the spatial model involved, and Gower and Hand (1995) on the presentation of the
analysis as a biplot.
The title, element names and construct pole names in the PrinGrid plot are nodes in a net that
may be dragged to different positions to make the plot more readable. RepGrid places them so
they do not overlap one another and connects the text to the locations on the plots with a line that
will redraw as you change the positions of the text so that the spatial data presented is not
distorted.
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8 Representing construct networks: RepNet
The RepNet tool in Rep IV may be used on its own for entering, editing and sharing graphic
representations of construct networks, and also in conjunction with RepGrid, for example in
element elicitation. The content of nodes in nets may be dragged to RepGrid panes to become
elements or construct poles (as can text from documents), and vice versa. In addition, all the
RepGrid graphic analyses are output as RepNet nets which makes them easy to enhance through
appropriate editing and to store as editable graphics.
The theory and application of construct representation techniques is described in the literature on
argument forms, entailment meshes, bond graphs, concept maps, petrinets, influence diagrams,
causal maps, belief nets, semantic networks and so on (Toulmin, 1958; Pask, 1976; Blundell,
1982; Novak and Gowin, 1984; Reisig, 1985; Oliver and Smith, 1990; Sowa, 1991; Lehmann,
1992; Mintzes, Wandersee and Novak, 1998; Novak, 1998; Mintzes, Wandersee and Novak,
2000; Bryson, Ackermann, Eden and Finn, 2004). Nets and grids are complementary
constructivist techniques, and may be used together to help people to explore their ideas about a
topic, make them more explicit and discuss them with others.
8.1 Net syntax of node and line types
Nets consist of nodes which may be joined by lines. Nodes have a named type, a textual label
which names them and is generally displayed, and a textual note which annotates them and is not
generally displayed. The label or note, or both, may be an empty string. Lines between nodes
may be decorated in various ways, usually as directed arrows. The collection of node and line
types available provide a syntax in which can be represented the semantics of the kind of net that
can be drawn. The node type determines the style of appearance of nodes of that type.
Below is a Toulmin-style “argument diagram” in a net syntax having six types of nodes:
‘Grounds,’ ‘Modality,’ ‘Claim,’ ‘Backing,’ ‘Warrant’ and ‘Rebuttal.

RepNet “argument diagram” example from Toulmin (1958)
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Below is a Novak-style “concept map” in a net syntax having three types of nodes: ‘Ideas’ as
text with an oval surround, ‘Examples’ of them as text with a rectangular surround and ‘Link
labels’ as text without a surround that labels the link between nodes formed by two lines.

RepNet “concept map” example from Novak and Gowin (1984)
Below is a “semantic network” for a simple ontology of family relationships in a net syntax
having seven types of nodes: ‘Concept,’ ‘Primitive,’ ‘Individual,’ ‘Role,’ ‘Constraint,’ ‘∨,’ and
‘∃,’ and two types of line, an arrow and a negated arrow.

RepNet “semantic network” for a family ontology
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8.2 Entering nodes
When the “New Net” button in the Rep IV Manager is clicked a blank RepNet window opens as
shown below. At the top is an editing area with a popup menu showing the types of node
available and a text input field for the node label. If one types a label in this field and keys
“return” or “enter,” then a new node is created of the type selected on the popup menu. To
support rapid entry, the text entered becomes selected so that further typing replaces it.

RepNet initial window for a new net
The node types available for this net and some nodes entered initially are shown below.

RepNet nodes being entered
The “Idea” type is used for concepts, “Example” for examples of them, and “Link” is used
between a pair of arrows to link concepts. The “Group” type provides a labeled enclosure that
may be used to group other items and, because an enclosure is a node, the group may itself have
links or be enclosed. The “Note” type is provided for annotation, and “Title” for titling. This set
of types provides a suitable syntax for a wide range of net applications.
The label text is wrapped automatically to be enclosed in a rectangle with its width about forty
per cent more than its height, and the surrounding shape specified by the node type is fitted
around this. You can take control of the wrapping by inserting the backslash character, “\”, at
places where you want to break the line. You can specify an unbroken line by putting a backslash
character at the end of it.
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8.3 Selecting, positioning, deleting and editing nodes
Nodes may be selected by clicking in them, and are then highlighted to show they have been
selected. Multiple selections may be made by holding down the “shift” key while clicking. All
nodes may be selected through “Select All” on the “Edit” menu or keying CMD-A. A set of
contiguous nodes may be selected by clicking outside them to draw a temporary “selection
rectangle” around them as shown below.

Selection rectangle being used to select enclosed nodes
A node may be repositioned by clicking in it and dragging it to a new position. All the selected
nodes may be repositioned together by clicking and dragging one while holding down the “shift”
key to prevent the other nodes from being deselected.
Nodes may be deleted by pressing the “delete” or “backspace” key after selecting them.
A node may be opened for editing in the edit area by double-clicking in it. This opens the editing
area if it is closed and brings up the node type on the popup menu and its label in the text input
field. Either may be changed as required and then pressing the “return” or “enter” key will
update the node appropriately.
8.4 Entering and deleting lines
As shown below, as the mouse is used to move the cursor across a node, the cursor changes
shape to indicate what action may be performed by clicking and dragging. In the center it
becomes a hand to indicate that the node can be grabbed and repositioned. At the right edge of a
node it becomes a line (with an arrow head or other decoration if appropriate) to indicate that a
line may be drawn from that node to another. At the left edge of a node it becomes an eraser to
indicate that the same action will erase any line drawn.

Hand, line and eraser cursors with the mouse at different positions over a node
Clicking in the node when the cursor indicates a line and dragging to another node until the
cursor changes to a star indicating the second node has been detected enters a line connecting the
two nodes. Below is shown a line in process of being drawn between the nodes labeled
“changes” and “states” at the lower right.

8-4

Lines with arrowheads being entered
Note that “changes” is essentially a link label for the link between the idea of “water” and that of
“states.” RepNet supports the labeling of links between concepts by treating the link label as a
node in its own right. This is the most general and flexible way of supporting link labels (and
bipartite graphs), enabling links to have types if appropriate, and several links to share the same
label if appropriate. As shown below where “can be” and “as in” are used as shared labels this
facility avoids the duplication of link labels and simplifies and clarifies the meaning of the net.

A node “link” type being used to support shared link labels
RepNet supports several styles of line and, if more than one is available, buttons appear at the
top right of the edit area allowing the style of line to be selected as shown below.

Selection of style of a line
Clicking in a line style button selects it, and the cursor will take the line style at the left and right
edges of a node. Dragging from one node to another as described above enters a line based on
the selected line style.
Lines are drawn from one of eight positions around a node that are selected automatically to
minimize the length of the line and to ensure that it is always in the direction of the relative
positions of the node. When nodes are dragged its lines are recomputed automatically, and when
a node is deleted its lines are also deleted.
A line between nodes may be over-written by entering a line with a different style. A line
between nodes may be erased by dragging the eraser symbol between the nodes.
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8.5 Covering and exposing the editing area
When a net is completed the editing area may be covered by clicking in the dark rectangle at the
top of the vertical scroll bar on the right of the net window and dragging it upwards. This drags
the net up to cover the edit area, and it may be dragged down again at any time to expose the edit
area. When a normal net file is opened from a file the edit area is covered, and when a new net is
created by opening a “master” file (Section 8.10) or clicking on the “New Net” button the edit
area is partially exposed.
The editing area has an additional pane which may be exposed dragging the dark rectangle down
further. As shown below, the node types available are shown with their shapes and color
schemes to support rapid node entry. Clicking on one of these creates a node of that type as if it
had been selected in the popup menu above and the “return/enter” key pressed.

Node type buttons in the editing area
8.6 Enclosure nodes
One of the possible node types support by RepNet is an ‘enclosure node’ where a node can act as
a container for other nodes. The “Group” node type in the default syntax for nets is an enclosure,
and its application is illustrated below.

Enclosure nodes used to group other nodes
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An enclosure node is created in the normal way, but it takes account of any selected nodes and
positions itself to contain them. When it is dragged to a different position it repositions the
enclosed nodes. Lines may be drawn between en enclosure node and other nodes in the normal
way.
Enclosure nodes may be resized. The cursor changes to a double arrow symbol at each corner of
and enclosure node, and clicking and dragging may be used to resize the node.
8.7 Contextual menu for node alignment
When the cursor is moved around a net it become a hand when over the central area of a node
and an arrow when outside a node. The hand cursor symbol has a menu icon on its right
indicating that a menu is available if one holds the “control” key down and clicks, or right-clicks
with a two-button mouse. Shown below is the contextual menu that appears when this is done
while the cursor is over the top node of the net being used as an example.

Contextual menu when cursor is over a node
Selecting “Align Nodes” causes RepNet to align any selected nodes with the node under the
cursor. It aligns the node centers either horizontally or vertically according to which requires the
least movement. This usually corresponds to the user’s intentions. The most important visual
effect is that any lines between the nodes become horizontal or vertical lines which gives the net
a neater appearance. Selecting “Edit Node” opens it for editing as if it had been double-clicked.
8.8 Copy and paste, and drag and drop
Selected nodes and the lines between them can be copied into the clipboard through the “Copy”
command in the “Edit” menu or by keying CMD-C. RepNet puts both the net data and a bitmap
image in the clip in such a way that it is able to paste the data back into a net whereas other
programs, such as word processors, paste the image in their documents.
Net data in the clipboard may be pasted into another net through the “Copy” command in the
“Edit” menu or by keying CMD-C. Each node type used in the data to be pasted must have the
same type name defined in the net in which it is to be pasted. The data pasted may change
appearance if the node type in the receiving net has a different graphic representation. Lines
between nodes are also pasted into the receiving net.
Text data in the clipboard may be pasted into a net. Each line of text creates a new node of the
type selected in the popup menu.
When you paste data into a net, RepNet places it at the point where you last clicked in the net.
Hence, to set the location for pasting, click in the net before you paste.
Drag and drop behaves much the same as cut and paste except that RepNet puts the net data in
the drag item for its own use and the text of the node labels in for use by other applications. To
distinguish between repositioning selected nodes and dragging copies of them, one must hold the
“alt” or “option” key down when dragging in a node to indicate that it should become a drag
item. When this is done the drag item is indicated by a gray rectangle initially surrounding the
selected nodes.
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Dragging a selected node, or nodes, and dropping them into the same net is a rapid way of
duplicating those nodes.
8.9 “Save,” “Save As…,” “Undo,” and “Print”
When the data in a RepNet window is changed the “Save” item in the “File” menu becomes
active as does the “Undo” item in the “Edit” menu. You can save the changed data under its
original name through the “Save” command. The “Save As…” command in the “File” menu is
always active and lets you save the net in a different file.
RepNet supports multi-level undo through the “Undo” command at the top of the “Edit” menu
(or CMD-Z).
The “Print” item in the “File” menu may be used to print the net image to the currently selected
printer. The “Page Setup” item may be used to adjust the scale and orientation of printing, and
Rep IV stores whatever format is selected so that it will be retained when the application is
terminated and restarted. Under Windows XP the page margins may be set, and “Page Setup”
should be used when the application is first installed to ensure these are set up appropriately.
8.10 Net master files
The “New Net” button creates a new net with some predefined node types which provides a
syntax adequate for many applications. However, a wide variety of sets of node types may be
used to support many forms of nets for different purposes such as semantic networks, bond
graphs, argument analysis, concept maps and so on. Other versions of Rep IV enables new types
of nodes to be created and stored as a syntactical structure in “master” files which behave like
any other net file except that when they open a copy is made with the name “Untitled.”
Thus master files are a way of distributing various syntactical structures for nets suited to
different applications of the RepNet tool. Rep IV is distributed with various sample nets from
different disciplines together with master files for the syntax of those nets.
Master files are useful for issuing syntax nets containing only the node and line types to be used
for different representation systems. However, they can also contain a net and hence may also be
used for other purposes, such as issuing student tests where some nodes are left blank to be filled
by the student.
8.11 Grid analyses in RepNet
The graphic analyses produced by RepGrid are RepNet nets with some extended features and can
be edited, copied and pasted, stored, and so on using RepNet capabilities.
The graphic output from the PrinGrid analysis consists of a net of nodes and lines which includes
special nodes having no label but displaying as a cross or a ball. These special nodes may be
selected, dragged, copied and pasted in the normal way. Hence, the entire graphic output, or any
part of it, may be selected, copied and pasted into another net.
The graphic output from the Display and Focus analyses consists of a graphic object together
with a title node. The graphic object behaves in much the same way as a node in that it can be
selected, dragged, copied and pasted. The net below shows Display, PrinGrid and Focus outputs
pasted into a single net with the Focus graphic output selected for dragging.
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Grid analyses in a net
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9 Integration with other applications
The tools in Rep IV have been designed to operate separately as stand-alone facilities, and also in
an integrated way among themselves and in conjunction with other applications such as word
processors, spreadsheets and web browsers.
9.1 Integration between RepGrid and RepNet
Nodes in nets may be selected and then copied and pasted, or dragged and dropped, onto a
RepGrid window, and the node labels are treated as text entries. The RepGrid elements pane
shown below was populated by selecting, dragging and dropping some of the nodes at the lower
right of the concept map about water shown in Section 8.1.

Net nodes selected, dragged and dropped into a grid elements pane
Similarly, items in grids may be selected and then copied and pasted, or dragged and dropped,
into a RepNet window, and become the labels of new nodes having the type selected on the
popup menu. The net below was populated by selecting, dragging and dropping the elements in
the grid window shown above. Thus grids may be created from nets and nets from grids.
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Grid elements selected, dragged and dropped into a net
9.2 Integration of RepGrid and RepNet with other applications
The copy and paste, and drag and drop, data interchange works equally well with material in
other applications such as text files and spread sheets. For example, a document in a text editor
that allows multiple discontiguous selections, such as Microsoft Word, may have various words
selected which are then dragged to the elements pane of a grid to become its elements, or to a net
to become its nodes.
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10 Versions of Rep IV
There are three versions of Rep IV based on the same tools and interfaces.
11.1 The Personal version of Rep IV
The Personal version of Rep IV is intended to make grid and net tools freely available for
personal and educational (non-commercial) use. We have simplified the functionality as much as
possible to make it easy to use, and hope that it will find a place in schools and in courses
introducing students to personal construct psychology and the representation of construct
networks through grids and nets. It should also allow anyone interested in the techniques to
explore them personally as they see fit. The greater functionality of the other versions is built on
the same foundations with similar user interfaces, so that this version may also be used to
explore potential applications of the more powerful versions. For many uses involving the
individual analysis of grids with up to 15 elements and 15 constructs the Personal version may
suffice—our intention is that it should be adequate for many applications.
11.2 The Research version of Rep IV
The Research version extends the Personal version with facilities for professionals having a
background in personal construct psychology who need a full range of grid analysis tools with no
limitation on grid size, including the SocioGrids tool (Shaw, 1980) to analyze multiple grids. It
supports conversational elicitation of new grids, rapid entry of existing grids, and import/export
of grid data in a variety of formats, all through researcher-scriptable interaction. For single grids,
in addition to Focus and PrinGrid, it provides crossplots, statistics, sorted matches, selective
analysis and weighted analysis. For multiple grids having overlapping sets of elements or
constructs, SocioGrids provides the capabilities to create and analyze composite grids, to
compare pairs of grids, to generate a ModeGrid of commonly used constructs, and to output
SocioNets linking those grids having similar patterns of construing.
The Research version also supports those facilitating groups of individuals using the Personal
version. RepNet is extended to allow new types of net to be defined with a syntax of node and
line types suited to specific purposes. It supports the saving of nets as clickable images for use in
web documents, and user-scriptable import, export and interaction with nets for integration with
other applications. For example, an instructor might provide students with the Personal version,
together with a shorter, more specific manual than this one, and use the Research version to
provide the students with net syntax master files that have types and terminologies appropriate to
the subject area, and to support social interaction through comparisons of students’ grids.
11.3 The Web version of Rep IV
The Web version extends the Research version for those wishing to operate public or private
WebGrid servers offering the capability to elicit and analyze grids over the Internet or a local
network with customized interactive dialogs and privacy of data. It can also be used on a standalone machine to enable a web browser to be used for grid elicitation with full multimedia
integration.
The web services provided are scriptable by those managing the server, and may be extended to
support specialist requirements such as those of knowledge management, clinical trials, social
surveys or market research. A typical application is large-scale data collection through grids and
questionnaires followed by the use of the multi-grid analysis tools to interpret the data collected.
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11.4 Table comparing features of versions of Rep IV
The table below shows the features of the different versions in greater detail.
Rep IV Version
Feature

Personal

Research

Web

Full color support in graphic output

Preset

Selectable

Selectable

Unicode (UTF-8)
(non-Roman text in nets and grids)

Supported

Supported

Supported

Copy & Paste, Drag & Drop
(transfer data to and from other applications)

Supported

Supported

Supported

XML data interchange

--

Supported

Supported

RepNet: Representation Nets

Included

Included

Included

Presets: e.g. argument forms, concept maps

Provided

Provided

Provided

Enter & edit nodes and lines

Included

Included

Included

Copy and paste images to other applications

Bitmap

Vector/bitmap

Vector/bitmap

Multi-page and fit-to-page printing

1-page

Included

Included

Define net syntax of node and line types & styles

--

Included

Included

Set up a default new net

--

Included

Included

Save net as preset master for personal version

--

Included

Included

Annotate nodes

--

Included

Included

Use URL annotation to access web and local files

--

Included

Included

Save net as PNG image for display on web

--

Included

Included

Generate HTML image map (clickable image)

--

Included

Included

Scriptable import/export, interaction & analysis

--

Included

Included

RepGrid: Grid Elicit, Enter and Edit

Included

Included

Included

Maximum size

15 by 15

Unlimited

Unlimited

Enter & edit

Included

Included

Included

Reads PLANET, RepGrid 2 and WebGrid files

To max size

Included

Included

Scriptable rapid entry of existing grid data

Included

Included

Included

Scriptable interactive elicitation (Pegasus)

Included

Included

Included

Meta-values: open, any, none, not-applicable, unknown

Open only

All

All

Set up a default new grid

--

Included

Included

Annotation of elements and constructs

--

Included

Included

Scriptable import/export

--

Included

Included

RepGrid: Grid Analysis

Included

Included

Included

Display plot

Preset

Selectable

Selectable

Focus plot (sort & hierarchical cluster analysis)

Preset

Selectable

Selectable

Principal Components plot (factor analysis)

1st by 2nd

Selectable

Selectable

Focus matches, sorts and links data as text

--

Included

Included

Principal Components loadings data as text

--

Included

Included

(also used for grid analysis plots)
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Crossplot of elements on selected constructs

--

Included

Included

Pairwise Comparison plots (Minus & Compare)

--

Included

Included

Statistics (construct ranges, means, correlations)

--

Included

Included

Sorted element and construct matches

--

Included

Included

Analyze only selected elements and constructs

--

Included

Included

Weight elements and/or constructs

--

Included

Included

Minkowski metric with fractional powers for matches

--

Included

Included

Scriptable analysis (e.g. complexity measures)

--

Included

Included

SocioGrids: Multiple Grids Analysis

--

Included

Included

Analyses can be based on common elements or on
common constructs or both

--

Included

Included

Composite grids (merge grids for joint analysis)

--

Included

Included

Pairwise Comparison plots (Minus & Compare)

--

Included

Included

ModeGrid (commonly used constructs or elements)

--

Included

Included

SocioNets plot based on common elements/constructs

--

Included

Included

Interactive, incremental SocioNets plot in RepNet

--

Included

Included

ModeGrid & SocioNets data as text

--

Included

Included

Minkowski metric with fractional powers for matches

--

Included

Included

Web Services: WebNet & WebGrid

--

--

Included

Web services run on local machine, LAN or Internet

--

--

Included

WebDoc: document server

--

--

Included

WebNet: clickable nets as web images

--

--

Included

WebGrid: web-based grid elicitation and analysis

--

--

Included

Automatic grid cache for distributed data collection

--

--

Included

Integration with multimedia and other applications

--

--

Included

Scriptable for other languages and puposes

--

--

Included

Personal

Research

Web
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11 Background material
Articles relating to RepGrid and RepNet and their applications my be found at
http://repgrid.com/reports
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